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Meetingworks “Free” Version 

Introduction 
When you download and install the free 5-participant license 
of Meetingworks from the web, you will have the capability of 
using the entire tool set for up to five Windows participants 
connected to your Chauffeur machine on a LAN. 

There are two modules to download: Chauffeur and 
Participant.  The Chauffeur package includes all of the tools 
you will need to create and run a Meetingworks agenda, along 
with the Word macros to create a report.  It can be installed 
on your Windows machine that you plan to use to lead a 
meeting (all necessary server capabilities are included, so it 
doesn’t require another server).  The Participant code is 
meant to be installed on each Windows machine you want to 
use as a participant.  These participant machines need to be 
connected to the Chauffeur machine on a LAN. 

The free version of Meetingworks is always current and has no 
time limit.   

The Windows participant is meant to be used in a face-to-face 
meeting where there is a public display.  When you upgrade to 
the Connect version (paid mode), you’ll be able to skip the 
Windows participant code if you want and have participants 
access the Chauffeur machine via a web browser.  With 
Connect, participants can be seated in the same room or 
anywhere in the world and all relevant data will be visible on 
their screens (in their browser). 

This document is meant to help you get started with the free 
version.  The same sample agenda can easily be used with the 
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Connect version of Meetingworks (with additional features and 
options for participant registration). 

Getting Started 
Once you have downloaded the free version (both Chauffeur 
and Participant modules), install them (Chauffeur code on your 
“leader” machine and Participant code on up to five Windows 
participant machines that are connected to the Chauffeur on a 
LAN). 

On the Chauffeur machine, create a folder outside the 
Program Files path.   

For example: 

C:\Meetingworks\Meetings\Sample 

NOTE:  You may already have a C:\Meetingworks folder 
created during installation.  If you took the defaults and have 
a recent version of Windows (e.g., XP, NT, 2000), 
Meetingworks recognizes this and creates a folder outside the 
Program Files path. 
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Starting Chauffeur and Setting 
the Environment 

Opening Chauffeur 

  Open Chauffeur by double-clicking on the Chauffeur icon 
in the Meetingworks Program Folder. 

 
The Chauffeur window opens, displaying menus for use in 
running an agenda. 

You can run an agenda from any folder you want.   

To set the environment in Chauffeur, click Session | Session 
environment.  The Current Session Environment dialog box 
displays. 
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The Meetingworks 
Session Environment 
is the folder from 
which the meeting will 
be run.  The folder 
contains the agenda 
file and all input files 
needed to run the 
meeting. 

You might also want 
to save documents, 
slide shows, etc. in 
the same folder. 

Find the folder you want and click OK. 

Loading the Sample Files 
Installation of Meetingworks created a folder called Program 
Files\Meetingworks\Samples.  All of the files you need to run 
the sample agenda are contained in this folder.  There are two 
options for loading the sample files into the folder you want to 
use for running the sample agenda: 

OPTION 1 

Using Windows Explorer, copy all of the files in the Program 
Files\Meetingworks\Samples folder to your newly created 
folder (C:\Meetingworks\Meetings\Sample).   

OPTION 2 

In Chauffeur, click Session | Backup/load session files | Load 
session files.  Find the Program Files\Meetingworks\Samples 
folder and follow the Meetingworks prompts. 

Opening the Agenda 
In Chauffeur, click File | Open.  Select the agenda. 
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It is a good idea to run your agenda displaying the 
Meetingworks tool names (at least until you are comfortable 
with running the agenda). 

To display the tool names click Options | Display tool names. 



6  •  Starting Chauffeur and Setting the Environment Meetingworks Sample Guide 

The Meetingworks Sample Agenda 

 

The sample agenda that you install with Meetingworks contains 
at least one of each type of step.   

NOTE:  Some of the steps in this agenda are meant to be used 
only with the Connect version (e.g., Connect Features, Send 
final HTML report) 
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Printing an Agenda Report (Optional but 
Recommended) 
The sample agenda contains instructions for running steps in 
an area called Facilitator notes.  Although you can read these 
from Chauffeur (while running the agenda), it is helpful to 
print them out from the Meetingworks AgendaPlanner tool.   

  Open AgendaPlanner by double-clicking on the 
AgendaPlanner icon in the Meetingworks Program Folder.  Click 
File | Open and locate the sample agenda.  Once it is open, 
click File |Print |Facilitator Notes. 
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Registering Participants 
To register participants, click Session | Set participant roster.   

The number of 
workstations that 
display in this dialog 
box depends on the 
maximum workstation 
count (Session menu, 
Set maximum 
workstation count 
option.)   

The Session Setup dialog box displays. 

 

To register a participant, double-click on one of the empty 
workstation icons. 

 

The Participant Roster dialog displays.  Enter the participant 
name and any other information you know or want to use as an 
affiliation during the meeting.  Also choose a Participation 
Mode. 
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Participation Mode  Identifies the participant’s mode. 

NOTE:  With the free version of Meetingworks, the only 
participation mode available is Local participation. 

Local participation (same time / same place and not 
Internet)  Designates a participant in a face-to-face meeting.  
This is the default.   

Once you have completed the information for each 
participant, click Send registration to participants and then 
click Exit registration. 
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Windows Participant 
Once the chauffeur has sent registration, participants can 
access the meeting. 

Pre-meeting: 

This is most often done 
by the chauffeur before 
the participants enter 
the room. 

Windows Participant—Pre-meeting 
Assuming you have set up a local area network (LAN), you can 
map a participant station to view the Chauffeur machine.  In 
fact, Meetingworks Windows participant code prompts you in 
the mapping process if you choose to do so.   

 Once you have installed the participant code on a station to be 
used by a participant, start the participant and view the main 
screen: 

 

 

 

Status Messages: 

Waiting for the 
Chauffeur means either 
1) Chauffeur isn’t 
running or 2) there is a 
network problem. 

Waiting for instructions 
means you are 
connected, but no tool 
has been sent to the 
participant. 

 
Click Options.  
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The Participant Options dialog box displays. 

 

Choose a Startup option and a language to be used by this 
participant.  Click Participant configuration. 

 

Assign one or more participant station IDs and browse to find 
the common data directory (a.k.a. working directory). 
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Once you have set up this Windows participant, the name you 
registered in Chauffeur displays on the screen. 

If you happen to be 
sharing this workstation 
and have assigned 
multiple participant 
Station IDs to it, you 
will still just see one 
name on this screen. 
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Running the Sample Agenda 

Running Steps 
To run a step, highlight it, and then either click Run step  
or press Enter. 

 

What’s Wrong with Meetings? 
The “What’s Wrong with Meetings” sample agenda includes at 
least one of each type of Meetingworks tool.  You may run all 
of the steps in the agenda or just those steps you want to see 
or practice on at any given time.  If you do skip steps, 
remember that sometimes a step depends on steps above it for 
input files.  You may also modify any of the steps to suit your 
needs. 

There are several Manual steps in the agenda that are used as 
placeholders or section titles for the next few steps.  A slide 
show can be run to review meeting objectives, ground rules, 
and outcomes.  A “parking lot” will contain unfinished business 
or issues gathered throughout the meeting.  

OPENING/INTRODUCTIONS 
You don’t usually run a Manual step.  If you do run this step, 
click Enter to end the step. 

Run slide show (optional) 
This step will need to be modified to run on your Chauffeur 
machine.  Double-click on the step and browse to find your 
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PowerPoint.exe program.  Also, erase the Program parameters 
and browse to your current meeting folder to find the 
PowerPoint slide show. 

NOTE:   We suggest you either skip this step or run a slide 
show using PowerPoint from your desktop.  The External 
Program tool works fine, but it is difficult for us to ship 
meaningful specifications for all clients to use. 

When you are finished with the slides, click File | Exit. 

Open parking lot 
To run the Organize step, click Run step.  This step is set up to 
Continue processing the agenda (i.e., continue running 
throughout the meeting.  Chauffeur will start the Organize 
step but you can minimize the Parking Lot and immediately 
“hot key” (ALT+Tab) to Chauffeur and proceed with the 
agenda.  The Organize step used for Parking Lot will run in the 
background. 

To use the parking lot, you can click on the minimized 
Organize tool at any time.  The first time you use this parking 

lot, click New , or click File I New.  The Specify Window 
Title dialog box displays. 

 

Type Parking Lot in the text box and click OK. 

Adding and Editing Items in the Parking Lot 

To add items to the Parking Lot, click Add , or select the 
Edit menu and choose Add.  The Add Item dialog box displays. 
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Type the item you want to add, and select the Level Option 
(same level as current selection or as a subitem of the current 
selection). 

Click OK. 

To edit an item, highlight it, and click Edit , right click and 
click Edit item, or click Edit |Edit item.   

NOTE  If you have entered items and you would like to save 
the items, click File | Save to the default output file to save 
the results as Parking Lot.mw.  You can do this several times 
throughout the meeting. 

Problems with Traditional Meetings 
Meeting tasks begin with a brainstorming tool (Generate).  
Participants type and send up to three items that interfere 
with the productivity of meetings.  The group then discusses 
and edits the brainstormed items, producing a list of items to 
be evaluated.  The chauffeur edits the list using the Organize 
tool.   

List problems encountered in traditional meetings 

Generate Step 
Instructions 
(single topic 
brainstorm) 

To run the Generate step, click Run step.  This step runs in 
Chauffeur mode, and there is just one question for participants
to answer. 

 



16  •  Running the Sample Agenda Meetingworks Sample Guide 

Instructions to participants: 

“Send one idea at a time, each followed by the Send (F2) key. 

To use the scratchpad, click Scratchpad (F7).  To send items to 
the scratchpad before sending to the group list, click Send to 
scratchpad (F5).  You can edit or delete items in the 
scratchpad; when ready to send, click on one or more of the 
items and click Send. 

When you have reached your limit, your screen will display 
‘Please wait’.” 

Once participants have finished, click File | Save and exit 
generate. 

Edit problem list 

Organize Step 
Instructions 

To run the Organize step, click Run step.  This step begins in 
Outliner mode, which shows all participant responses from 
Generate.   

You can use Outliner mode throughout the discussion.  Learn 
to open a second window (File | New) and tile the windows 
(Window | Tile).  Drag unique items into the second window.  
Also, type in categories (Add item) in the new window and 
drag related items under the category name.  The arrow keys 
on the Organize menu help move items (or use the ALT-arrows 
on your keyboard). 

In this case, it might be useful to switch to Discussion mode.  
Highlight the first item on the list, and double-click on the 
word Outliner in the Organize Status Bar (bottom of the 
screen).  The Set Organizing Mode dialog box displays. 

Click on the Set Discussion Mode option and type 2 for the 
number of minutes to spend on each item. 

Click OK. 

The screen splits into two windows, the Discussion Item 
window and the Discussion Mode Results window. 

Spend time editing each of the statements in the Discussion 
Item window using the Discussion Points listed (Is it clear?, 
appropriate?, unique?, singular?) 

When you want to add an item to the Discussion Mode Results 
window, click Add at first level if you want to use this as a main 
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topic or the Add at sublevel if you want to add it as a subitem 
of a topic already placed in the window. 

NOTE  Try highlighting part of an item and adding just 
the highlighted text to the Results window.  Also try 
adding an item to the Results window using the buttons 
and menus.   

When you have completed the list in the Discussion Item 
window, click Exit discussion mode. 

Organize is now back in Outliner mode, displaying the results 
of editing using Discussion mode. 

Make any additional changes. 

NOTE  Try using buttons on the toolbar to indent items, 
turn numbering one, or spell checking. 

When finished, select the click File | Save to the default file.  
The Default Output File dialog box displays.  For now, ignore 
what is on this window.  Simply click OK. 

To exit the step, click File | Exit organize.  Click Yes when 
prompted. 

Rate problems for effect on productivity 
Participants then rate the list of problems created in Organize 
using a scale of 1 to 5, where: 

5 = MAJOR DETERRENT TO MEETING PRODUCTIVITY 
3 = SOME EFFECT ON PRODUCTIVITY 
1 = NOT MUCH EFFECT ON PRODUCTIVITY 

The results are reviewed to see the top-rated problems as well 
as how much agreement (variability) there is for each item.  
Graphs and comments are saved for the final report. 

Evaluate Step 
Instructions 
Rating 1-5 

To run the Evaluate step, click Run step. 

The Participant Polling dialog box displays.  Describe the task 
to the participants and then click Start Polling. 
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Instructions to participants: 
“Type a number between 1 and 5 for each item (problem).  
You may also type an A to abstain. 

To move from one line to the next, use the TAB key, the Enter 
key, or the down-arrow key. 

To type a comment for an item, press the F4 key.  Type the 
comment, and then press the Enter key. 

At any time, you can sort your results by pressing the F3 key. 

When you have rated each item, press the F2 key to send your 
evaluation. 

Your screen will display ‘Please wait’.” 

One all participants have sent their ratings, the Summary chart 
displays.  The blue bars represent the average ratings and the 
red bars represent the variability, or degree of agreement.  A 
tall red bar means there is little agreement. 

Click on the bars on the Summary chart to view how each item 
was rated by participants.  Markers indicate where you can 
find comments. 

At any time, repoll one or more participants by selecting the 
Options menu and choosing Poll participants. 

When you are finished viewing the results, click File | Save as. 

The default graph file name displays Summary - Rated 
Meeting Problems.wmf in the File Name text box.  Click on 
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the Also save all distribution graphs as individual files option.  
The Save All Distribution Graphs dialog box displays. 

Type Problem in the File name prefix text box.  Click OK. 

To exit the step, click File | Exit evaluate.  Choose Yes when 
prompted. 

NOTE  When the Report Title dialog box displays, it is OK to 
ignore it in this case.  Click OK. 

Reduce list of problems 
Using File Editor, the results from the evaluation are edited so 
that just the top problems are carried into the next part of the 
agenda, where solutions will be generated. 

File Editor Step 
Instructions 

To run the File Editor step, click Run step. 

The results from the Evaluate step display  

Lead the group through an exercise to remove any items that 
received a low score (they aren't problems).  To remove scores 
and variability, click Edit | Remove scores and variability.  
After typing your screen might look like this: 

 

When you are finished editing the file, click File | Save to 
default output file. 

The file named in the agenda, prob4.mw, displays in the File 
Name text box.  Click OK. 

To exit the step, click File | Exit editor.   
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Electronic meeting benefits tutorial 

Organize Step 
Instructions 

To run the Organize step, click Run step.  This step begins in 
Outliner mode, which displays the Benefits of Electronic 
Meetings.mw file (an outline file with sublevels) in collapsed 
form. 

Double-click on an item to display the subitems.  This tutorial 
will explain the benefits of using electronic meeting support to 
make traditional meetings more productive.  This exercise 
should help participants think of solutions in the next Generate 
step. 

When finished, click File | Exit organize.  Organize will ask if 
you want to exit without saving and you can click Yes to exit. 

List ways electronically-supported meetings can 
help solve problems 

Generate Step 
Instructions 
(Multiple topics) 

To run the Generate step, click Run step.  This step runs in 
Participant mode, and there is a list of topics within which the 
participants may brainstorm ideas. 

Instructions to participants: 
“Send one idea at a time, each followed by the Send (F2) key. 

To choose a topic to work on, click Choose topic (F9).  The list 
of rated meeting problems displays.  Highlight the one you 
want to work on, and press the Enter key. 

Because this step is running in Participant mode, no comments 
display on the Chauffeur screen (and public display) unless the 
chauffeur opens topic windows. 

To open a topic window, select the View menu and choose 
Open a topic window. 

The Select a topic to view dialog box displays. 
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Highlight a topic you want to open for viewing, and click Open 
to view topic items. 

NOTE 1  The plus mark in front of a topic indicates that there 
are comments for the topic. 
 
NOTE 2  Keep in mind that opening too many of these windows 
will confuse participants.  Encourage them to use their F10 key 
to view the lists of submitted comments.  It is usually 
advisable to open a maximum of 4 or 5 windows, then use the 
Windows option to Tile them.  Once participants have finished, 
click File | Save and exit generate. 

Edit list of solutions 

Organize Step 
Instructions 

To run the Organize step, click Run step.  This step begins in 
Outliner mode, which shows all participant responses from 
Generate.  The step displays items collapsed, and the topics 
for which participants have submitted comments in Generate 
display a plus mark. 

To view subitems for a topic, double-click on the topic to 
expand its subitems.  Through group discussion eliminate 
duplicates, edit, and add items as needed.   

When you are finished editing the outline, click File | Save to 
the default output file. 

To exit the step, click File | Exit organize.  Choose Yes when 
prompted. 
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ELECTRONIC MEETING ROOMS 
This section of the agenda demonstrates Meetingworks’ two 
analysis tools, Cross Impact and Multiple Criteria Analysis. 

With Cross Impact, the participants rate a number of 
frequently touted benefits of electronic meetings against two 
types of meeting improvements, EFFECTIVENESS and 
EFFICIENCY. 

Multiple Criteria Analysis is used to analyze some cities where 
this type of electronic meeting room should be introduced.  In 
this step, some criteria are weighted, and then the cities are 
scored.  Final results show the weighted scores.   

Analyze impact of room types on goals 

Cross Impact Step 
Instructions 

To run the Cross Impact step, click Run step. 

The Participant polling dialog box displays.  Click Start Polling. 

Instructions to participants: 
“Rate each benefit (of using EMS) for EFFICIENCY and 
EFFECTIVENESS using a scale of -5 to +5.  You can also enter 
comments by pressing the Comment (F4) key, typing your 
comment, and then press the Enter key to return. 

Once you have completed rating for EFFICIENCY, click Choose 
Topic (F9) to select EFFECTIVENESS.  Press the Enter key. 

When finished rating both criteria, press the Send (F2) key to 
send your evaluation.” 

When all participants have sent their responses the Summary 
table displays a grid.  A Summary graph displays if desired (the 
button toggles it off).  The columns are sorted from left to 
right using the total calculations in the last (sum) row.  The 
rows are sorted top to bottom using the last (sum) column. 

You can change the Display option by clicking on the down-
arrow and choosing an option from the drop-down list box. 

You can display summary charts by double-clicking in the top 
of a column or at the beginning of a row.  For this example, 
display the column summary charts (EFFECTIVENESS and 
EFFICIENCY) and while viewing each, click File | Save all 
graphs.  Here you have many choices for saving.  If you want 
to try them all, first click Save item (row) summary graphs.  
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Type the prefix CI Row.  Click OK.  Repeat the process and 
click Save topic (column) summary graphs.  Type the prefix CI 
Summary Column.  Click OK.  Repeat the process and click 
Save topic and item distribution graphs.  Type the prefix CI 
Item.  Click OK. 

When finished viewing the results, click File | Exit cross 
impact.  Choose Yes when prompted. 

NOTE  When the Report Title dialog box displays, it is OK 
to ignore it in this case.  Click OK. 

Choose sites for electronic meeting rooms 
(optional) 

Multiple Criteria 
Analysis 
Step Instructions 

To run the Multiple Criteria Analysis step, click Run step.  

The Participant Polling dialog box displays.  Click Start Polling 
button. 

Instructions to participants: 
WEIGHTS 

“The list of criteria for opening an electronic meeting room 
are presented on a list.  You have 100 points to spread across 
the criteria.  Type a number in front of each criterion.  Use 
the TAB key, the Enter key, or the down-arrow key to move to 
the next item.  MeetingWorks keeps track of how many points 
you have used and how many are remaining. 

You can also enter comments by pressing the F4 key, typing 
your comment, and then press the Enter key to return. 

When you have weighted all the criteria, press the Send (F2) 
key to send your evaluation.” 

When all participants have sent their responses, a message will 
display asking if you want to view the weighting results.  If you 
choose No, the Participant Polling screen for scores displays.  
If you choose Yes, the Summary chart for Weights displays.  
The blue bar represents the average value for the weights.  
The red bar represents the amount of agreement (variability). 

When you are ready to have participants score the alternatives 
(cities), select the Options menu and choose Poll participants 
for scores. 
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Instructions to participants: 
SCORES 

“The list of alternatives (cities) are presented on a list.  Each 
will be scored against each of the criteria.  

For each criterion, you must award one alternative (city) a 
100 and one alternative (city) a 0.  All other cities can be 
scored anywhere from 0 to 100.   

This technique places equal value on each participant’s first 
choice and each participant’s last choice.  It is not intended to 
award 100 points to the item per se, but instead to put a 
relative placement of values on the alternatives. 

Once you have completed work for the first criterion, press 
the F9 key to click next criterion.  The next criterion is 
automatically highlighted.  If this is the one you want to work 
on next, press the Enter key. 

When finished rating all criteria for each of the alternatives 
(cities), press the Send (F2) key to send your evaluation.” 

When all participants have sent their responses the Final 
Scores Detail displays.  In the grid at the bottom of the screen, 
the columns are sorted from left to right using the total 
calculations in the last (sum) row.  The rows are sorted top to 
bottom using the last (sum) column.  The total column 
represents average scores times average weights using the 
Group Mean method. 

As with Cross Impact, you can double-click on cells within the 
grid to “drill down” to information you want to view.  Try 
using the various display options, filtering options, menus, 
analysis methods, and scenarios. 

WRAP-UP 
Before ending the meeting, the chauffeur shows the Parking 
Lot to make sure all issues have been addressed in action 
plans. 

A final report is generated using formatting commands 
provided with MeetingWorks. 
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Cruise the parking lot 
To display the Parking Lot window, maximize it. 

Near the end of the meeting, it is a good idea to look at any 
items to decide if there are any action items to be recorded, 
or if any items can be removed from the Parking Lot list.  
When you are finished, click File | Save to the default output 
file.  The contents are saved as Parking Lot.mw and can be 
printed in your final report or used in any other document. 

When you are finished with the Parking Lot, click File | Exit 
organize.  Choose Yes when prompted. 

Print final report (optional) 
This step will need to be modified to run on your Chauffeur 
machine.  Double-click on the step and browse to find your 
Winword.exe program.  Also, erase the Program parameters 
and browse to your current meeting folder to find Meeting 
Problems Shell.doc. 

NOTE:  A simpler method is to start Word from your desktop 
and browse to find the Meeting Problems Shell.doc in your 
meeting folder. 

External Program 
Tool 
Step Instructions 

To run the External Program Tool step from the agenda, click 
Run step.  Word will open the document shell named in the 
Meetingworks agenda. 

Once the document opens, it is a good practice to immediately 
save the document with a new name, thus preserving the 
formatting commands in the shell document for reuse. 

To save the document with a new name, click File | Save as.  
Type a new name in the folder you want to use. 

Click on Meetingworks toolbar icon  (Run formatting 
commands). 

When you ran the agenda, meeting results were recorded in 
the Meeting Problems.rpt.  Other files you saved are also 
available to insert into the final meeting document.   

Run formatting commands searches for all MWCommands 
within the document and processes them sequentially, 
replacing the MWCommand with the specified data, and 
formatting it as indicated in the formatting dialog boxes. 



26  •  Running the Sample Agenda Meetingworks Sample Guide 

If the specified data is not available, Run formatting 
commands leaves the MWCommand and moves to the next one.   

Choosing from Multiple Step Outputs 

There may be multiple outputs found in the report for a given 
step.  Multiple outputs can result when: 

• The step was run more than once during the 
meeting.  For example, you may have run an 
Evaluate step a second time if the item list was 
changed after one evaluation. 

• The step was run when you rehearsed the agenda 
and you did not refresh the report file. 

• Multiple outputs were saved while the step was 
being run.  For example, you may have chosen to 
reevaluate data using a different criterion during an 
Evaluate step.  Or, you may have saved multiple files 
to the report file during an Organize step. 

When multiple outputs are found, the Results From Step Run 
Multiple Times dialog box displays. 

 

A list of the outputs that were found for the step in the report 
file is displayed.  The step type, time it was run, and step 
name are listed.  If you created more than one output of a 
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step while running the step, additional lines will be shown 
listing the output number and the time it was created. 

Select the output you want to insert in your document by using 
the up and down arrow keys or the mouse to highlight the 
item.  Then click OK. 

Choosing from Saved Graphs 

There may be multiple graphs found in the report for a step.  
The Select Graphs to be Formatted dialog box displays.   

Choose graphs you want to insert from the list box: 

OK  Formats only the selected graph.  Highlight a graph on the 
list and click OK. 
Format one  Formats the selected graph, then allows you to 
select another to be formatted, without leaving the dialog 
box. 
Format all  Formats all graphs on the list. 

When the Save All Distribution Graphs option in an Evaluate 
step was used, the list of graphs can be narrowed to include 
only the graphs with the File name prefix specified.   

File name prefix  Specifies a text string to use to select a 
subset of the list of graph files saved in the Evaluate step. 
Number of columns  Sets up columns into which the graphs 
will be inserted. 
Redisplay  Displays the list of graphs using the File name 
prefix specified. 

Now that you have inserted your meeting results, you can 
modify the report in any way you want.  We recommend that 
you save it with another name (e.g., Meetings Demo Final 
Report.doc). 

NOTE  If you ran the sample agenda but used different 
names for graphs, your file names might not be listed 
when the Select Graphs to be Inserted dialog box 
displays.  To correct this, you may need to edit the shell 
document.  For example, if you did not use the prefix 
Problem for the distribution graphs, you can use the 
Find/Replace option to change references to Problem in 
the shell document to reflect your naming convention. 
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For the Cross Impact step, you can insert all the graphs you 
saved.  The simplest way is to type a 2 in the number of 
columns text box, then click Format all the graphs in the list 
button.   

Try using other options.  Type a prefix (e.g., CI Summary by 
Row) in the prefix text box and click Redisplay.  Type a 2 in 
the number of columns text box, and then click Format all the 
graphs in the list button.  Repeat the process for the other 
graphs you saved. 

There are several ways you can improve the appearance of 
your document.  Now that all the meeting data is formatted, 
you are strictly working with your word processing application.  
You can change the fonts, font sizes, styles, column sizes and 
names, picture sizes, page breaks, headers, and footers. 

Recommendations (using Word commands): 

Change the size of the Evaluate Summary chart.  Highlight the 
picture, select the Format menu, and choose Picture.  Change 
the size to 50% by 50%.  Click OK. 

Change the table formats to a fancier format.  Select the 
table.  Select the Table menu, choose Table AutoFormat.  
Choose a format you like.  Click OK.  (You can also highlight 
the heading row, center the text and bold it.)  It is also a good 
practice to change the Table Titles to reflect what is really in 
the columns (e.g., Problems instead of Item #). 

Check the pagination.  Add Page breaks wherever necessary to 
make a more readable document.  New topics should begin on 
a new page. 

Build a Table of Contents.  Highlight the current Table of 
Contents with the left mouse button.  Click on the right mouse 
button and click Update field.   
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More about Chauffeur 

Modifying the Agenda from Chauffeur 
Store Updates stores 
the changes you make 
to the agenda until 
you actually close the 
agenda. 

Modifications made to 
the agenda from 
Chauffeur are not 
saved unless you click 
File | Save as. 

If you need to modify a step before you run it, double-click on 
it to open up the tool dialog.  Make changes to any option or 
field that isn't “grayed out”.   

You can either click Run the step or Store updates.  

 

The Session Menu 

Session status helps 
you save and restore 
meeting data. 

Session environment 
shows directory and 
path information. 

Restart from the first 
steperases check marks 
next to steps you have 
run. 
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The Options Menu 

Report options assist 
you with testing an 
agenda, and then 
erasing test results to 
begin a meeting. 

Display options 
determine how your 
Chauffeur screen 
appears during a 
meeting. 

 

 

Closing Chauffeur 
Close Chauffeur by clicking File | Exit chauffeur.  A series of 
dialog boxes display.  Some of them are: 

If you are finished 
with the 
workstations, click 
Yes.  If you do not 
want the participants 
to exit, click No.   

Session Status asks 
if you if you want to 
“record” the status 
(retain the check 
marks by the steps). 

If you want to backup 
your meeting data at 
this time, Click the 
second box.  You can 
perform the backup 
using Chauffeur 
menus as well. 
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Appendix 

Sharing Workstations 
If you want to share workstations, you can press CTRL+S on a 
station to display the Participant Setup Information dialog box. 

The maximum 
participant count 
(Chauffeur session 
menu) must reflect at 
least the total 
number of 
participants you plan 
to register. 

Your license for 
Meetingworks will 
dictate the maximum 
number of 
participants you can 
register for a 
meeting. 

Exiting the Windows Participant 
This keystroke 
combination is not 
published in the online 
Participant Help. 

To exit the Meetingworks Participant screen, press CTRL+X.  
You will be prompted Yes/No if you really want to exit. 

 


